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EasyMAM V.2.0.0.0 
 
Preface 
 
Dear Easy MAM customer, 
 
We would like to welcoming you to Easy Media Suite family via Easy MAM program. While we are 
willing to communicate with our customers to be sure if they get sufficient support and the program 
meets all customers’ needs, we appreciate if you can give feedback about your opinon related to Easy 
MAM.  
Please send your questions, suggestions and assistance requests to support@easymediasuite.com 
General feedback: info@easymediasuite.com 
Customer Support phone number: +90 212 582 23 07 
Customer Support fax number: +90 212 582 93 95 
 
This section provides an overview of the Easy MAM user documentation. You find it on the product 
page at: http://www.easymediasuite.com/en/products/media-asset-manager> "Downloads" 
 
Legal notice 
 

This document contains information which is protected by copyright. All rights are reserved. 
Reproduction, adaptation, or translation without prior written permission is prohibited, except as 
allowed under the copyright laws. Use of this manual and compact disc(s), usb etc. supplied for this 
pack is restricted to this product only. Additional copies of the programs may be made for security and 
back-up purposes only. The software described in the manual is owned by Devtek Bilişim Elektronik 
San. Tic. Ltd. Şti. Resale of the programs in its present form or with alterations, is expressly prohibited. 

Please send your comments or questions to: 
Devtek Bilişim Elektronik San. Tic. Ltd. Şti. 
Address: Kaptanpasa District Piyalepasa Boulevard Famas Plaza B Blok Floor:15 No:105-108 
Okmeydani Sisli-Istanbul / Turkey  
Tel.: 90 212 582 23 07 
Fax: 90 212 582 93 95 
info@easymediasuite.com 
http://www.easymediasuite.com/ 
 
Overview 
 
Easy Mam system is designed with user friendly interface. Training or deep knowledge in computers 
are not strictly required. All functions have been described in this user manual. In order to setup the 
system and to utilize the program efficiently, it is recommended to read the all sections.   
If you have further questions, sales and support team are always ready and pleased to help you,  
support@easymediasuite.com  
 
Getting Started 
 
Introduces the Easy MAM and describes how to set up and start working with the product. The user 
manual contains the description of Easy MAM of all functions.  
 
 
 
 
 
 
 
 
 
 
 
 

mailto:support@easymediasuite.com
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Manual Conventions 

Italic text indicates a text on software UI. 

Underlined text indicates a key stroke on keyboard. 

Bold and italic text indicates graphics shown in this manual. 
 

Symbols 

 A note provides important information, recommendations, reminders and 

suggestions. 

 

                 The See Also notes refer to other relevant sections, chapters or manuals. 

  

  The caution paragraph indicates a potentially dangerous operation. 

 

Using the Mouse 

Click Press and release the left mouse button. 

Right-click Press and release the right mouse button. 

Double-click Click the left mouse button twice in rapid succession. 

Drag&drop Move the mouse while holding down the left mouse button and then 

release. 

 

Installation 

 Before the installation process, you must ensure that a file archiver software is 

installed on the computer to extract installation files from compressed file. 

 

 If the computer has an antivirus software; before extracting installation files from 

compressed file, you must ensure that antivirus doesn’t block all executable files by 

setting it’s security level lower or deactivating it until installation process is over. 

 

 Before the installation process, you must ensure that the driver of graphics card is 

properly installed. 
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Graphic 1: Easy MAM Main Window 
 

BASIC TERMS and GENERAL INFORMATION 
 
1.Settings Menu 
1.1 Settings Window 
1.1.1 General Settings 
 
When click in to Settings menu, a window will be open as shown Graphic 2.  
In the first tab of "Settings Window" general settings will appear (Graphic 2).  
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Graphic 2: General Settings 
 
These settings are as follows: Language, Confirm Movement, Search on Archive, Show Story Board, 
Existing File Timeout, Default Page Size.  
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Graphic 3: Language Settings 
 
Language: This section is used to change the language. It is required to restart the Easy MAM after 
language changing.  

1) Click the ‘Language’ section  
2) Choose the required language 
3) Click the ‘Save’ button to save the changes  
4) Restart the program to be able to use the program with required language  
5) Click the ‘Cancel’ button to close the settings panel without making change 

 



7 
 

 
 

Graphic 4: Confirm Movement 
 
Confirm Movement: It is used, if the users would like to have confirmation message after deleting, drag 
and dropping, copying etc. the assets.  

1) Click the ‘Confirm Movement’ box 
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 5: Search on Archive 
 
Search on Archive: Click the associated box to be able to search the assets on archive.   

1) Click the ‘Search On Archive’ box 
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 6: Show Story Board 
 
Show Story Board: This option provides to show the main asset’s content at intervals of 10 seconds as 
a small picture.  

1) Click the ‘Show Story Board’ box  
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 7: Existing File Timeout 
 
Existing File Timeout: If the file already exists in the MAM this option asks about the file (to keep it or 
replace with the existing file) and the warn small page stay duration also can be set.  

1) Choose the time for the duration or click the never box to not allowed the confirmation 
message. 

2) Click the ‘Save’ function to save the changes  
3) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 8: Default Page Size 
 
Default Page Size: It arranges the file assests number of one page in content section. 

1) Choose the number of assets that required in one page in the content section.  
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change  

 
 
1.1.2 Social Settings 
Social settings as it is shown on the Graphic 9 connects the Easy MAM to the social media such as 
twitter and also it can be implemented for the others like facebook, instagram and so on. 
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Graphic 9: Social Settings 
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Graphic 10: Consumer Key 
 

1) Use ‘Consumer Key’ to select the social media  
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change  
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Graphic 11: Consumer Secret 
 

1) Enter the Twitter API code which is coming from twitter application  
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 12: User Access Token 
 

1) Enter the Twitter API code 
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 13: User Access Secret 
 
1) Enter the Twitter API code 
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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2. Help Menu 
 
It is a short way to create a shortcut of the useful functions like frames, numbers etc. It also provides 
system update.  
 

 
 

Graphic 14: Help Menu 
 

1) Click the ‘Help Menu’  
2) Choose ‘About’ to check the software updates of the system  
3) Choose ‘Player Shortcut’ to have the keyboard on the screen  
4) Click the ‘Help Menu’ twice to close the sections  

 
2.1 Player Shortcut 
Shortcuts can be used in the program as shown in the Graphic 15.   
These are as follows: 

1-  (- frame): Used to go back one frame on the video being played. 
2-  (- vol): Used to decrease the volume during playback. 
3-  (+ frame): Used to go forward one frame on the video being played. 
4-  (- sec): Used to go back one second on the video being played. 
5-  (play): Used to play selected video. 
6-  (+ sec): Used to go forward one second on the video being played. 
7-  (- min): Used to go back one minute on the video being played. 
8-  (+ vol): Used to increase the volume during playback. 
9-  (+ min): Used to go forward one minute on the video being played.  
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Graphic 15: Player Shortcut 
 
2.2 How to Use Window 
 

: To add new content at list. 
 

: Used to add a new proxy server. 
 

: Used to add a new thumbnail. 
 

: Used to save changes. 
 

: Used to cancel last operation. 
 

: Used to delete selected item. 
 

: Used to edit selected item. 
 

: Used for advanced search. 
 

: Used for the regulation of authority. 
 

: Used to refresh list. 
 

: Used to restore deleted items. 
 

: Used to record the changes made. 
 

: Used to search files. 
 

: To display the version list of the item. 
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Graphic 16: How to Use Window 
 
 
 
3.System Admin Settings 
3.1 System Admin 
System administrator settings can be edited in this section. In order to change the admin, the workflow 
should be as follows below.  
 
 

 
 

Graphic 17: System Admin 
 



20 
 

 
 

Graphic 18: System Admin Name 
 

1) Write the ‘Name’ in the space in front of the labelling name word 
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

 

 
 

Graphic 19: System Admin Surname 
 

1) Write the ‘Lastname’ in the space in front of the labelling lastname word  
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 20: System Admin Email 
 

1) Write the ‘Email’ address in the space in front of the labelling Email word 
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

 

 
 

Graphic 21: System Admin Username 
 

1) Write the username in the space in front of the labelling ‘Username’ word 
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 22: System Admin Password 
 

1) Write the ‘Password’ in the space in front of the labelling ‘Password’ word 
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

 
3.2 Projects  
Create a new project under the ‘Projects’ tab or making changes to existing projects can be 
performed.  
 

 
 

Graphic 23: Project 
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Graphic 24: Projects 

 
Click + button to create a new project.   
Then the new page will open in the Graphic 25 
 

 
 

Graphic 25: Projects 
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To create a new project;  
 

 
 

Graphic 26: Add Project Window 
 

1) In order to create a new project, project name should enter the space in front of the related 
function as shown above  

2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

 

 
Graphic 27: Add Project Window 

 
1) In order to create a new project, ‘Database (DB) Name’ should enter the space in front of the 

related function as shown above  
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 28: Add Project Window 
 

1) In order to create a new project, ‘Database (DB) Server IP’ should enter the space in front of 
the related function as shown above  

2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

 

 
 

Graphic 29: Add Project Window 
 

1) In order to create a new project, ‘Database (DB) Username’ should enter the space in front of 
the related function as shown above  

2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 30: Add Project Window 

 
1) In order to create a new project, ‘Database (DB) Password’ should enter the space in front of 

the related function as shown above  
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

 
 

 
 

Graphic 31: Projects 
 
Click the highlighted button above to refresh the project list.  
 
3.2.1 General  
Server IP = To the IP address of MAM Server to connect is entered 
Name = Project name 
Db_name = Database name at MAM server. 
Db_username = Database username 
Db_password = Database password. 
 
In this section allows to change server ip where the interface is connected besides allows to change 
admin name and password.   
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Graphic 32: General Project Settings 
 

 
 

Graphic 33: General Project Settings Server IP 
 

1) In order to connect a MAM server to create a project, ‘Server Ip’ address should enter   
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 34: General Project Settings Name 
 

1) In order to create a project, project ‘Name’ should enter   
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

 

 
 

Graphic 35: General Project Settings Database (DB) Name 
 

1) In order to create a project, ‘Database (DB) name’ should enter   
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 36: General Project Settings Database (DB) Username 
 

1) In order to create a project, ‘Database (DB) Username’ should enter   
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

 

 
 

Graphic 37: General Project Settings Database (DB) Password 
 

1) In order to create a project, ‘Database (DB) Password’ should enter   
2) Click the save function to ‘Save’ the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

 
3.2.2 User Groups 
User groups and users of each group are created or deleted in this section besides their authorizations 
can be edited on Easy MAM. Users groups can be active or passive in this section. 
 



30 
 

 
 

Graphic 38: User Groups 
 

 
 

Graphic 39: User Groups tools 
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In order to refresh the groups, use the tool in blue circle on the left top of the user groups panel   
 

 
 

Graphic 40: User Groups Tool 
 

1) In order to create a usergroup, use the + tool in blue circle on the left top of the ‘User Groups’ 
panel   

2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 41: User Groups Tool 
 

1) In order to create a usergroup, if the + tool is clicked, Graphic 41 will appear   
2) New ‘Group Name’ and activation can change in this panel  
3) Click the ‘Save’ function to save the changes 
4) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 42: User Groups Tool 
 
In order to refresh the usergroups, use the tool in blue circle on the right top of the user groups panel   
 
 

 
 

Graphic 43: User Groups Tool 
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To select a group, use the tool in blue circle on the right bottom of the user groups panel. 
 
 

 
 

Graphic 44: User Groups Tool 
 
To select the user, use the tool in blue circle on the right bottom of the user groups panel.  
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Graphic 45: User Groups Tool 
 
To dedicate the user to the required user groups, use the tool in the blue circle on the right bottom of 
the user groups panel.  
 
3.2.3 Users 
Username, password, name, surname, e-mail address, authentication is edited in this section. 
 



36 
 

 
 

Graphic 46: Users Setting 
 

 
 

Graphic 47: Users Setting Tool 
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1) In order to allow the users to log in to MAM via own computers with password, click ‘Active 
Directory’ label on the left top    

2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

 

 
 

Graphic 48: Users Setting Tool 
 

1) In order to allow the users to log in to MAM via own computers with password, enter domain 
address of the ‘Active Directory’ server      

2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 49: Users Setting Tool 
 

1) In order to add ‘Users’ to Easy MAM click the + box      
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 50: Users Group Tool 
 

1) In order to add users to ‘Active Directory’, click the box in the blue circle on the left top    
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

Differences between, users and active directory users is, while users can only log in in the Easy MAM 
active directory users can also enter users Easy MAM account.  
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Graphic 51: Users Group Tool 
 

1) In order to delete one or more users to click the box in the blue circle      
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

 
3.2.4 Process Server 
Process Server displays the performance and used capacity of all servers which are Proxy Server, 
Thumbnail Server, File Transfer Server, Quality Check Server. These servers do not appear in the 
default settings they must be entered manually by ip address.  
 

 
 

Graphic 52: Process Server 
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Graphic 53: Process Server Tool 
 

1) In order to allow project admin to access the ‘Process Server’ click the box in the blue circle      
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

 

 
 

Graphic 54: Process Server Tool 
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In order to refresh the process server panel, click the box in the blue circle      

 
 

 
 

Graphic 55: Process Server Tool 
 

1) In order to check the ‘Process Server’, click the box in the blue circle      
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 56: Process Server Tool 
 

1) In order to check the ‘Thumbnail Server’, click the box in the blue circle      
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

 

 
 

Graphic 57: Process Server Tool 
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1) In order to check the ‘Quality Server’, click the box in the blue circle      
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

 

 
 

Graphic 58: Process Server Tool 
 

1) In order to check the ‘File Transfer’, click the box in the blue circle      
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 59: Process Server Tool 
 

1) In order to delete the ‘Process Servers’, click the box in the blue circle      
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

 
 
3.2.5 File Server 
It is used to display situation (location and active, passive states) of the Proxy and Thumbnail files 
which are transmitted on the File Transfer Server.  
File servers can be added by different users. 
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Graphic 60: File Server 
 

 
 

Graphic 61: File Server Tool 
 

1) In order to allow project admin to access ‘File Server’ click the box in the blue circle      
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

 



47 
 

 
 

Graphic 62: File Server Tool 
 
In order to refresh the file server panel, click the box in the blue circle      

 

 
 

Graphic 63: File Server Tool 
 

1) In order to add a file server, click the box in the blue circle      
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 64: File Server Tool 
 

1) In order to delete a file server, click the box in the blue circle      
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

 
3.2.6 Archive Server 
There are two types of Archive Servers in Easy MAM which are Archive Server and LTO (Linear Tape 
Open). New servers can be added using the button. Files Servers can be added in this section for 
aging module.  
 

 
 

Graphic 65: Archive Server 
 



49 
 

 
 

Graphic 66: Archive Server Tool 
 

1) In order to allow project admin to access the ‘Archive Server’ click the box in the blue circle      
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

 

 
 

Graphic 67: Archive Server Tool 
 
In order to refresh the archive server panel, click the box in the blue circle      
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Graphic 68: Archive Server Tool 
 

1) In order to add archive server, click the + box in the blue circle      
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

 

 
 

Graphic 69: Archive Server Tool 
 

1) In order to delete archive server, click the box in the blue circle on the top      
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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3.2.7 LTO Archive Server  
 
1. Install XenData6 Server and Alert Module - v 6.22 by downloading from 
"http://xendata.com/support-xendata6-server/downloads/XDServerx64-6.22.2716.300.msi" address.  
2. Install XenData Workflow API software - v 6.25 by downloading from "http://xendata.com/support-
xendata6-server/downloads/XDWorkflowAPIx32-6.25.2626.-1.msi" address.  
3. Apply license for these softwares  
4. Apply configurations settings as below sample for the "C:\Program Files (x86)\XenData\Workflow 
API\MediaServers.xml" file.  
Not :  
<Server>easy_mam_srv</Server> => this is remote computer name that contains shared folder  
<Path>Easy_MAM_Storage</Path> => this is shared folder name. 
("\\easy_mam_srv\Easy_MAM_Storage")  
Configuration for MediaServers.xml file:  
<?xml version="1.0" encoding="utf-8"?>  
<!-- Sample XenData Workflow Configuration file -->  
<MediaServerList>  
<MediaServer ID="MyServer">  
<DLL>CIFSClient.dll</DLL>  
<Port>cifs</Port>  
<Server>easy_mam_srv</Server>  
<Path>Easy_MAM_Storage</Path>  
<User>easy_mam_srv\hasan</User>  
<Password>Fractal1978</Password>  
</MediaServer>  
</MediaServerList>  
//------------------------------------------------------------------------------   
5.Easy_MAM -> Admin Panel-> Archive Server  
Add New Server  
Choose LTO Tape as Server type  
Enter LTO Server configuration info  
Sample for above configuration:  
LTO ServerID : MyServer  
LTO Server : easy_mam_srv  
Archive Path : MAM_Archive\Files  
///End of configuration 
 

 
 

Graphic 70: LTO Archive Server 
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3.2.8 History 

In the history section the actions, which are performed by the users, are displayed and it is 
searchable according to the date, user or action type. 
 

 
 

Graphic 71: History 
 

 
 

Graphic 72: History Tool 
 

1) In order to see the ‘History’ according to ‘Username’ write the username in the space on the 
top  

2) Click the ‘Search’ button to see the result 
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Graphic 73: History Tool 
 

1) In order to see the ‘History’ according to action write the action name in the space on the top  
2) Click the ‘Search’ button to see the result 

 

 
 

Graphic 74: History Tool 
 

1) In order to see the history according to ‘Description’, write the description in the space on the 
top  

2) Click the ‘Search’ button to see the result 
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Graphic 75: History Tool 
 

1) In order to see the ‘History’ according to ‘Date’, choose the date in the calendar  
2) Click the ‘Search’ button to see the result 

 

 
 

Graphic 76: History Tool 
 

In order to have the ‘History’ details with excell file click the export button  
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Graphic 77: History Tool 
 
1) To decide the result number, choose the number on the right bottom  
2) Program shows the all result on the left button  

 
4.Projects 
When Easy MAM main screen, clicking on the project name seen in the Graphic 78, entering a user 
name and password can access the project window. Users can have access to only authorized for the 
project. 
 

 
 

Graphic 78: Easy MAM Main Window 
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Graphic 79: User Login 
 

1) To log in to Easy MAM, enter the username and password  
2) Click the Login box  

 
4.1 View Menu  
View menu provides three options to show them in an alternatively short way on the top of the 
program screen. It shows corresponding data which is choosen by the user which are Archive, File 
History, Metadata.  
 

 
 

Graphic 80: View Menu 
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4.2 Admin Panel 
It can make changes to the project within the project administrator privileges after loggin project. It is 
situated in the admin panel as Graphic 81 for changes. 
 

 
 

Graphic 81: User Admin Panel 
 
4.2.1 General  
 

 
 

Graphic 82: Admin Panel General Settings 
 

1) To enter the database ‘Server Ip’ Address, enter the ip address in the gap in front of the blue 
circle  

4) Click the ‘Save’ function to save the changes      
5) Click the ‘Cancel’ function to close the settings panel without making change 

 



58 
 

 
 

Graphic 83: Admin Panel General Settings 
 

1) Enter the project ‘Name’ in the gap in front of the blue circle  
2) Click the ‘Save’ function to save the changes      
3) Click the ‘Cancel’ function to close the settings panel without making change 

 

 
 

Graphic 84: Admin Panel General Settings 
 

1) Enter the ‘Database (DB) Name’ in the gap in front of the blue circle  
2) Click the ‘Save’ function to save the changes      
3) Click the ‘Cancel’ function to close the settings panel without making change  
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Graphic 85: Admin Panel General Settings 
 

1) Enter the ‘Database (DB) Username’ in the gap in front of the blue circle  
2) Click the ‘Save’ function to save the changes      
3) Click the ‘Cancel’ function to close the settings panel without making change  

 

 
 

Graphic 86: Admin Panel General Settings 
 

1) Enter the ‘Database (DB) Password’ in the gap in front of the blue circle  
2) Click the ‘Save’ function to save the changes      
3) Click the ‘Cancel’ function to close the settings panel without making change  

 
4.2.2 Mail Settings  
In this section allows to edit the dedicated names who receive the report as well as the transmit mail 
address. 
 
Server = Corresponding mail server address entered 
Port = Related port number entered where the mail report sends  
Email = Transmit mail address is entered  
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Password = Password of the transmit mail address is entered  
Day Interval = Report mails are sent at the entered duration intervals   
Hour = Report delivery time is entered  
Last Sent = Last time of report delivery time is shown  
Target Mail List = Dedicated users who receive the report are entered  
 

 
 

Graphic 87: Mail Settings 
 

 
 

Graphic 88: Mail Settings Tool 
 

1) Enter the corresponding mail server address  
2) Click the ‘Save’ button to save the changes  
3) Click the ‘Close’ button to close the window without making any changes  
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Graphic 89: Mail Settings Tool 
 

1) Enter the related port number where the mail report sends  
2) Click the ‘Save’ button to save the changes  
3) Click the ‘Close’ button to close the window without making any changes  

 

 
 

Graphic 90: Mail Settings Tool 
 

1) Enter the transmit mail address  
2) Click the ‘Save’ button to save the changes  
3) Click the ‘Close’ button to close the window without making any changes  
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Graphic 91: Mail Settings Tool 
 

1) Enter the ‘Password’ of transmit mail address  
2) Click the ‘Save’ button to save the changes  
3) Click the ‘Close’ button to close the window without making any changes  

 

 
 

Graphic 92: Mail Settings Tool 
 

1) Enter the required ‘Day Interval’ to send the mails  
2) Click the ‘Save’ button to save the changes  
3) Click the ‘Close’ button to close the window without making any changes  
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Graphic 93: Mail Settings Tool 
 

1) Enter the report delivery time  
2) Click the ‘Save’ button to save the changes  
3) Click the ‘Close’ button to close the window without making any changes  

 

 
 

Graphic 94: Mail Settings Tool 
 
Last Sent = Last time of report delivery time is shown  
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Graphic 95: Mail Settings Tool 
 

1) Click the + button to add new mail address  
2) Enter the ‘E_mail’ address in the space  
3) Click the ‘Save’ button to save the changes  
4) Click the ‘Close’ button to close the window without making any changes  
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4.2.3 User Groups 
User groups and users of each group are created or deleted in this section besides their authorizations 
can be edited on Easy MAM. Users groups can be active or passive in this section.  
 

 
 

Graphic 96: User Groups 
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Graphic 97: User Goups Tool 
 
To refresh the groups panel, use the item in blue circle. 
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Graphic 98: User Groups Tool 
 

1) Click the + button to add new group 
2) Enter the mail address in the space  
3) Click the ‘Save’ button to save the changes  
4) Click the ‘Close’ button to close the window without making any changes  
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Graphic 99: User Groups Tool 
 

1) Click the ‘A.D. Group’ to give active directory authorization to the dedicated group 
2) Click the ‘Save’ button to save the changes  
3) Click the ‘Close’ button to close the window without making any changes  
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Graphic 100: User Groups Tool 
 

1) Click the ‘Active’ item to give active directory authorization to the dedicated group 
2) Click the ‘Save’ button to save the changes  
3) Click the ‘Close’ button to close the window without making any changes  
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Graphic 101: User Groups Tool 
 
Click the item in the blue circle to refresh the user groups.  
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Graphic 102: User Groups Tool 
 

1) To select the ‘User Group’, click on to select group which is highlight with blue circle 
2) To select the ‘User’, click on to select user which is highlight with blue circle 
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Graphic 103: User Groups Tool 
 

1) Click the + item to add the users to the choosen user group 
2) Click the ‘Save’ button to save the changes  
3) Click the ‘Close’ button to close the window without making any changes  
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4.2.4 Users 
Username, password, name, surname, e-mail address, authentication is edited in this section.  
 

 
 

Graphic 104: Users 
 



74 
 

 
 

Graphic 105: Users Tool 
 

1) In order to allow the users to log in to MAM via own computers with password, click active 
directory label on the left top    

2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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Graphic 106: Users Tool 

1) In order to allow the users to log in to MAM via own computers with password, enter domain 
address of the Active Directory server      

2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 



76 
 

 

Graphic 107: Users Tool 

1) In order to add users to Easy MAM click the + box      
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 



77 
 

 

Graphic 108: Users Tool 

1) In order to add users to ‘Active Directory’ click the box in the blue circle      
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 

Differences between, users and active directory users is, while users can only log in in the Easy MAM 

active directory users can also enter users Easy MAM account 
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4.2.5 Authorization Settings  
Authority like (reading, writing, saving etc.) of the users and user groups can be edited in this section. 
 

 
 

Graphic 109: Authorization Settings 
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Graphic 110: Authorization Settings Tool 
 
There are two panels for authorization tool; to change the authorization settings of user group use the 
top panel, to change the authorization settings of user, use the bottom panel.  
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Graphic 111: Authorization Settings Tool 
 

1) In order to add or remove the rights for the users or user group click the corresponding box to 
the dedicated authorization      

2) Click the ‘Ok’ function to save the changes 
3) Click the ‘Cancel’ function to close the settings panel without making change 
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4.2.6 Metadata 
Metadata consists of four parts which are metadata, metadata groups, categories, supported formats. 
 

 
 

Graphic 112: Metadata 
 
 
4.2.7 Metadata Categories 
Data types are specified in the Easy MAM in this part which are int, double, text, string, date, list, bool.  
 

 
 

Graphic 113: Metadata Tools 
 
To refresh the metadata panel, use the item in the blue circle.  
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Graphic 114: Metadata Tool 
 

1) In order to add metadata type, use the + item  
2) The right small Add Metadata window will open, fill the metadata and type parts       
3) Click the ‘Ok’ function to save the changes 
4) Click the ‘Cancel’ function to close the settings panel without making change 

 
4.2.7.a Int Type  
It is used to write integer in the content. 
 
4.2.7.b Double Type 
It is used to write decimal numbers in the content.  
 
4.2.7.c Bool Type 
It allows to use check box refer to true or false options. 
 
4.2.7.d String Type  
It is used to write single line metadata in the content. 
 
4.2.7.e Text Type  
It allows to enter the datas more than one line in the content.  
 
4.2.7.f Date Type 
It allows to enter the date in the content.  
 
4.2.7.g List Type  
It allows to write the datas as list. 
 
4.2.8 Metadata Groups  
It is used to create the groups for the contents of the assests for the related assets.  
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Graphic 115: Metadata Groups 
 

1) In order to add metadata groups, use the + item  
2) Enter the group name 

 
 
 
 
4.2.9 Categories  
Content categories such as news or movie can be edited in this section 
 

 
 

Graphic 116: Metadata Categories 
 

1) In order to add metadata categories, use the + item  
2) Enter the category name 
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4.2.10 Supported Format  
It includes the formats for audio, video and documents which are supported by metadata. The format 
types which are included automatically or manually in this section could used in the Easy MAM as a 
metadata type. 
 

 
 

Graphic 117: Supported Formats 
 

1) In order to add metadata formats, use the + item  
2) Click the ‘Save’ function to save the changes 
3) Click the ‘Cancel’ function to close the window 
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4.2.11 Process Server 
Thumbnail server and proxy server are hosting in the process server. New server can be added and 
can observe current work situation in this tab.  
 

 
 

Graphic 118: Process Server 
 

 
 

Graphic 119: Process Server Tool 
 
To refresh the process server panel, use the button.  
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Graphic 120: Process Server Tool 
 

1) To add Proxy Server to the Easy MAM, use the item in the blue circle  
2) Click the ‘Save’ button to save the changes  
3) Click the ‘Cancel’ button to close the window 
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Graphic 121: Process Server Tool 
 

1) To add ‘Thumbnail Server’ to the Easy MAM, use the item in the blue circle  
2) Click the ‘Save’ button to save the changes  
3) Click the ‘Cancel’ button to close the window 
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Graphic 122: Process Server Tool 
 

1) To add ‘Quality Check Server’ to the Easy MAM, use the item in the blue circle  
2) Click the ‘Save’ button to save the changes  
3) Click the ‘Cancel’ button to close the window 
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Graphic 123: Process Server Tool 
 

1) To add ‘File Transfer Server’ to the Easy MAM, use the item in the blue circle  
2) Click the ‘Save’ button to save the changes  
3) Click the ‘Cancel’ button to close the window 
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4.2.12 File Server 
File server includes file information and new servers can be added. As well as active server can be 
made passive or active.  
 

 
 

Graphic 124: File Server 
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Graphic 125: File Server Tool 
 
To refresh the file server panel, use the button. 
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Graphic 126: File Server Tool 
 

1) To add new ‘File Server’, click + button  
2) Enter the information of ‘File Server’  
3) Click the ‘Save’ button to save the changes  
4) Click the ‘Cancel’ button to cancel the progress  
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Graphic 127: File Server Tool 
 

1) In order to make active or passive the ‘File Servers’ use the active box with corresponding to 
the file server  

2) Click the ‘Save’ button to save the changes  
3) Click the ‘Cancel’ button to close the changes  

 
4.2.13 Archive Server  
There are two types of Archive Servers in Easy MAM which are Archive Server and LTO (Linear Tape 
Open). New servers can be added using the button. Files Servers can be added in this section for 
aging module.  
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Graphic 128: Archive Server 
 

 
 

Graphic 129: Archive Server Tool 
 
To refresh the archive server panel, use the button.  
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Graphic 130: Archive Server Tool 
 

1) To add the new ‘Archive server’, click + button  
2) Enter the ‘name, computer name, username, password, path, server and server id’ 
3) Click the ‘Save’ button to save the changes  
4) Click the ‘Cancel’ button to cancel the changes  
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Graphic 131: Archive Server Tool 
 

1) To changes the activation of the ‘Archive Server’, use the button top  
2) Click the ‘Save’ button to save the changes  
3) Click the ‘Cancel’ button to close the changes  
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LTO (Linear Tape Open) Archive Server  
 

 
 

Graphic 132: LTO Archive Server 
 
1. Install XenData6 Server and Alert Module - v 6.22 by downloading from 
"http://xendata.com/support-xendata6-server/downloads/XDServerx64-6.22.2716.300.msi" address.  
2. Install XenData Workflow API software - v 6.25 by downloading from "http://xendata.com/support-
xendata6-server/downloads/XDWorkflowAPIx32-6.25.2626.-1.msi" address.  
3. Apply license for these softwares  
4. Apply configurations settings as below sample for the "C:\Program Files (x86)\XenData\Workflow 
API\MediaServers.xml" file.  
Not :  
<Server>easy_mam_srv</Server> => this is remote computer name that contains shared folder  
<Path>Easy_MAM_Storage</Path> => this is shared folder name. 
("\\easy_mam_srv\Easy_MAM_Storage")  
Configuration for MediaServers.xml file:  
<?xml version="1.0" encoding="utf-8"?>  
<!-- Sample XenData Workflow Configuration file -->  
<MediaServerList>  
<MediaServer ID="MyServer">  
<DLL>CIFSClient.dll</DLL>  
<Port>cifs</Port>  
<Server>easy_mam_srv</Server>  
<Path>Easy_MAM_Storage</Path>  
<User>easy_mam_srv\hasan</User>  
<Password>Fractal1978</Password>  
</MediaServer>  
</MediaServerList>  
//------------------------------------------------------------------------------  
5.Easy_MAM -> Admin Panel-> Archive Server  
Add New Server  
Choose LTO Tape as Server type  
Enter LTO Server configuration info  
Sample for above configuration:  
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LTO ServerID : MyServer  
LTO Server : easy_mam_srv  
Archive Path : MAM_Archive\Files  
///End of configuration 
 
4.2.14 Target Location  
It is used to select the location to send the data and enter the new target receive location.  
 

 
 

Graphic 133: Target Location 
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Graphic 134: Target Location Tool 
 
Use this button to refresh the target location panel.  
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Graphic 135: Target Location Tool 
 

1) Use + button to add new target location  
2) Enter the related information  
3) Click ‘Save’ button to save the changes 
4) Click ‘Cancel’ button to close the window  
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Graphic 136: Target Location Tool 
 
When you click on the key item (in blue circle), ‘Authorization Settings’ window will open to make 
decision who can send the file to the dedicated ‘Target Location’.  
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4.2.15 Rss (Rich Side Summary) List 
 
Rss List in the Easy MAM provides to collect all metadata in a file and also keeps them up to date. 

This function can be used for different purposes by different users.  

 

Graphic 137: Rss List 
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Graphic 138: Rss List Tool 

Use the button to refresh the Rss List.  
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Graphic 139: Rss List Tool 

1) To add new ‘Rss’ use + button  

2) Click ‘Save’ button to save the changes  

3) Click ‘Cancel’ button to cancel changes  
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Graphic 140: Rss List Tool 

1) Use the item on the left side in the circle to change the metadata types related to ‘Rss List’  

2) Then the right window will open 

3) Choose the ‘Metadata Type’ to make changes  

4) Click the ‘Save’ button to save changes 

5) Click the ‘Cancel’ button to close to configuration window 

5. Media Bin 

It is used to search the assets, to get the files from the archive, and to make trim means cutting and 

merge processes. Right click opens options according to the authorization of the users. 

Directory list appears according to the authorization of the users.  

Bin button is used to add new bin files.  



106 
 

 

Graphic 141: Media Bin 

 

Graphic 142: Media Bin Tool 

There are two different items in the media bin which are Archive and Search tools.  

Archive panel shows the all assets in the archive.  
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Graphic 143: Media Bin Tool 

Search panel allows to find the asset with corresponding search type like name or etc.  

When you right click on the media bin, the section as follows below will open. 

 

Graphic 144: Media Bin Tool – Add new bin 

Use this actions to add new bin.  

Rename: It is used to change folder name. 
 
Delete: It is used to delete folder 



108 
 

Authorization Settings: This setting help to delete authorization rights of users and groups. 
 

 
 

Graphic 145: Authorization Settings 
 
Archive Job Options: 
Make QC: Easy Media Archive has Quality Check server which checks the quality of the assets and 

shows the quality rate between zero and five to the users. Quality check process is performed to 

check whether the content is suitable for publication process through the process tab to see the 

process progress can be monitored.  

 

Graphic 146: Quality Check 
 
Schedule: Content of the set time to go through the process is carried out at a certain time in Quality 
Check. Time can set in schedule screen. 
 

 
 

Graphic 147: Schedule 
 
Do nothing: This option is scheduled to be activated for any actions. 
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Enable Watch Folder: By using this function, it is possible to up to date the file in Easy MAM 
simultaneously with the corresponding file which is choosen or created by the users.  
 

 
 

Graphic 148: Watch Folder 
 
Aging: Aging property is used archiving of unused files in a certain time dedicated to user decision. In 
this window three options appear; 

 

 
 

Graphic 149: Aging 
 
Interval: Days, weeks, months, years specified as options. 
 
Bin: It is used to select the related Bin file.  
 

1) Choose the ‘Archive Server’ for aging rules  
2) Choose the ‘Interval’ according to the ‘Day, Week, Month, Year’  
3) To choose the ‘Bin’ file click in to the bin box  
4) Click ‘Save’ button to save the changes  
5) Click ‘Cancel’ button to cancel changes  

 
Properties 

Information of bin is held in the properties section. 
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Graphic 150: Bin Properties 
 

1) Select ‘File Server’ to be able to select a file  
2) Select ‘Backup File Server’ to backup the files 
3) Select ‘Watch Folder’ if any related watch folder exists  
4) If the selected file is already in bin so existing file action window will open, to arrange the 

question of the action select the question 
5) Use ‘Aging Rule’ function for the related file in media bin and choose the following actions  
a) If all files should have aging rule click the apply to sub bins  
b) Choose the archive server to be able to archive the files 
c) Choose the ‘Interval’ for aging rule  
d) Choose the proxy or thumbnail sample it they are necessary 
6) Click the ‘Save’ button to save the changes 
7) Click the ‘Cancel’ button to cancel the changes  

 
Backup File Server: Select backup server. 
 
Watch Folder: It is used to select watch folder. 
 
Existing File Action: It is used to select exist files in the archive to make changes with aging rule, 
transfer location and authorizeds on the assets.  
 
5.1 Asset Window  
 
This function is used for preview window. This section also has other features as below. 

: Play button is used to play the selected content. 
: The Rewind button is used to go back 1 second on the video. 

: The Stop button is used to stop the video. 

: The Forward button is used to move forward for 1 second on the video. 

: Trim in button is used to start trim here if you want to use a certain part of the content. 

: Trim out button is used to finish trim here if you want to use a certain part of the content. 

: Clear button is used to clear the marked trim in and out points. 

: Add button is used to add the range of the selected trim points as new content. 

: The Volume button is used to turn the sound off and on. 
When the content is trimmed, it appears as new trim in the preview section. The new content also will 
be added to the content section as a new trim. 
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Graphic 151: Trim 
 
5.2 Asset Metadata 
Metadata information about the contents can be viewed and modified in Asset Metadata section. The 
subsections are below.  
Categories: Content categories such as news or movie can be edited in this section. 
Tag: Tags can be added and edited while searching for content in the Tag section. 
Smartsigns: This is the SmartSign icon that will be used when the content is broadcasted. 
File Info: Technical specifications such as video values, sound values, etc. can be viewed here  
Product Info: Information about the content is set here, such as the country, creation date, creator, etc.  
 

 
 

Graphic 152: Asset Metadata 
 
5.3 Content 
It shows the selected files and allows to send the data to the archives, allows to create proxy and 
thumbnail. It also allows to drag and drop.  
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Graphic 153: Content Window 
 
Files can be searched in the folder by using button. Details can be searched by using button. 
New content can be added to the content section via button. Button is used to refresh for showing the 
changes made. 
When you right click on any content in the Content window, you will see options such as Graphic 153. 
These options are as follows. 
 

 
 

Graphic 154: Content Properties 
 
Edit Asset: In this section, metadata information about the content can be edited. Details are available 
in Asset Metadata section. 
 
Authorization Settings: User authorizations are set. 
 
Delete: It is used to delete content. 
 
Send to: Two options appear. 
These options are: 
 
1.Archive: Content is sent to a pre-defined archive server. The letter A appears in blue color on the 
submitted content. 
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2.Target: The content is sent to the target location. 
 

 
 

Graphic 155: Send to Archive Display 
 

 
 

Graphic 156: Send to Target Display 
 
Get File: There are two options to get the file, which are proxy and original file. 
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Graphic 157: Get File by Proxy 
 
1.Proxy: The proxy sample of the content is downloaded in the computer. 
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Graphic 158: Get file by original file 
 
2.Original File: The original content is downloaded in the computer. 
 
Make QC: Quality Check is performed for the selected file.  
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Graphic 159: Quality Check 
 
When QC is performed in the media bin, it could be seen in the process function that QC is 
performing.  
 
NOTE: Some icons appear on the thumbnails in the Content section. If there is a green letter P on the 
top of the photo, this is the proxy file created. If there is a green letter T, it means thumbnail is created. 
The blue letter A indicates that your content is sent to the archive. If a file is archived, the archive icon 
disappears from the icons under the image as seen in Graphic 43. Tasks of the other icons are below: 
: It is used to delete content. 
: It indicates version information of content. 
: It is used to edit the authorizations. 
: It is used to edit the content. 
 
6. Process 
Processes such as proxy creation and archiving can be displayed in the process section. Besides, 
these processes can be searched according to date, server and type. Process consists of two parts as 
Waiting Process and Finished Process. 
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Graphic 160: Process Tool 
 

 
 

Graphic 161: Waiting Processes 
 

1) Use the type of the process from the group which is, ‘Thumbnail Generation, Proxy 
Generation, Transcoding and Quality Check’ 

2) Then the process about the choosen one will display 
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Graphic 162: Waiting Processes 
 
Choose the date to see the process which happens in that time.  
 
 

 
 

Graphic 163: Finished Process 
 
Finished process displays the finished operation.  
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Graphic 164: Finished process Tool 
 
Write the server name in the server box to see its processes. 
 

 
 

Graphic 165: Finished Process Tool 
 

1) Choose the type of the process from the group which is, ‘Thumbnail Generation, Proxy 
Generation, Transcoding and Quality Check’  

2) Then the process about the choosen one will display  
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Graphic 166: Finised Process Tool 
 
Choose the date to see the process which happened in that time 
 
7. Transfer Jobs 
Status of finished and transfer file can be track in this section. It also has searchable interface via date, 
target location and server.   
 

 
 

Graphic 167: Waiting File Transfer 
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Graphic 168: Waiting File Transfer Tool 
 
Choose the target transfer to see the result of the transmission to the required location.  
 

 
 

Graphic 169: Waiting File Transfer Tool 
 
Select the date to see the transmission in that time.  
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Graphic 170: Finished File Transfer 
 

 
 

Graphic 171: Finished File Transfer 
 
Write the server name in the server box to see its transmission. 
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Graphic 172: Finished File Process Tool 
 
Choose the target location to see its transmission.  
 

 
 

Graphic 173: Finished File Process Tool 
 

Choose the date to see the transmission in that time.  
 
8. History 
In the History section, the actions performed by the users are displayed and search can be done 
according to the date, user or action type. 
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Graphic 174: History 
 

 
 

Graphic 175: History Tool 
 

1) Write the username  
2) Click the search tool to see the history of related user 
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Graphic 176: History Tool 
 

1) Choose the action from the existing ones  
2) Click the search button to see the history of the dedicated action type 

 

 
 

Graphic 177: History Tool 
 

1) Write ‘Description’ for the content  
2) Click the ‘Search’ button to see the history of the description  
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Graphic 178: History Tool 
 

1) Select the start and end ‘Date’  
2) Click the ‘Search’ tool to see the result for the time  

 

 
 

Graphic 179: History Tool 
 
Use the export button to have the results in excel file.  
 
 
 



127 
 

9. Recycle Bin 
Deleted content can be viewed and searched in Recycle Bin. 
 

 
 

Graphic 180: Recycle Bin 

 

 

Graphic 181: Recycle Bin Tool 

1) Write the ‘Content’ name  

2) Click the search button to see the result  
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